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CPE and Course Evaluation 

During the webinar you will be provided with two keywords at two different times. Keywords are used in 
accordance with NASBA regulations, which require CPE providers to validate your attendance during live 
web-based events. Write down these keywords when they are provided. 

Shortly after the webinar ends you will receive an email from Intuit Professional Education containing a 
link to the Evaluation and CPE Eligibility Form. The keywords from the webinar must be entered on 
this form; just select them from the drop-down list. If the keywords are missing or inaccurate when the 
form is received, we will be unable to process your CPE certificate. 

Also, please complete the body of your evaluation. There are several statements provided to gauge your 
satisfaction with and overall experience in the webinar. Note that the scale for each statements starts and 0 
and ends at 10. A score of 0 (lowest score) means that you Strongly Disagree with the statement; a score 
of 10 (highest score) means that you Strongly Agree. We greatly appreciate any comments you can 
provide to help make webinars better for everyone, particularly if we did not deliver the highest quality of 
satisfaction. 

Question example:  

 

After entering the keywords and completing the evaluation, click the Finish button. Once the keywords 
are authenticated, your CPE certificate should arrive within 4-6 weeks. 

F  For CPE credit information, including the number of hours for which this course is eligible, please 

visit 

www.accountant.intuit.com/training  

 

 

 

Intuit, Inc. is registered with the National Association of State Boards of Accountancy 
(NASBA) as a sponsor of continuing professional education on the National Registry of 
CPE Sponsors. State boards of accountancy have final authority on the acceptance of 
individual courses for CPE credit. 

Complaints regarding registered sponsors may be addressed to the National Registry of 
CPE Sponsors, 150 Fourth Avenue North, Suite 700, Nashville, TN, 37219-2417. Web 

     site: www.nasba.org 

www.accountant.intuit.com/training
http://www.nasba.org/
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How to Use This Guide  
This section is designed to give you an understanding of the conventions and terminology used in this 
guide. These reference materials are designed to complement the information presented by the instructor 
and to act as a stand-alone training guide. 

 

Typographic Conventions  

We use certain typographic conventions throughout this manual. These conventions should help you use 
this manual more efficiently. The following is a general guide identifying each convention that may be 
presented: 

CONVENTION    MEANING  

 

F    Represents notes or other important information. 

P     Indicates tips or other timesaving information. 

[Text in brackets]  Generally used to indicate keystrokes.  

    Indicates where to find additional information about a feature. 

 

Terminology 
Some of the terms used in this guide are program specific, and some are related to the technology used. 
Use the following table as a reference for any necessary definitions: 

 

TERM    MEANING  

 

Right-click   Click the secondary mouse button 

REP Remote Entry Processing (process used to transmit client files on a pay-
per-return basis) 

MAPI MAPI is the acronym for Messaging Application Programming Interface. It 
is a set of Microsoft Windows functions that you can use to "email enable" 
applications without having to write the code to handle these complex 
issues 
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Section 1: Effectively Using the Client Display 
 

Since the columns of information are workstation specific, administrative personnel and preparers in a 
network environment can each have data displayed on their computers customized to fit their specific 
workflow. 

 

All Clients View 
When you click All Clients, the program displays all clients that match the current filter applied, if any. 
The default display categories for the All Clients view are: 

 Client Full Name, last name first  

 Client Number 

 Taxpayer Social Security Number 

 Current Status 

 Needs REP access? 

 State Return 

 

When editing this view, you may want to include information that usually requires accessing a clientõs detail 
to locate, such as email addresses, phone numbers, appointment dates or times, or federal program version 
numbers. You may also want to include indicators for missing data in the return, if the file is locked, or 
even how much a client has paid on their account. 
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e-file Clients 
When you click e-file Clients, the program displays e-file clients that match the current filter. The default 
display categories for the e-file Clients view are: 

 Client Full Name, last name first  

 e-file Status (Federal)  

 e-file Status (State) 

 Client Number 

 Taxpayer Social Security Number 

 E-file DCN 

 1st Extension Status (Ind) 

 

F  Several state specific filters will display if you have those state modules loaded (i.e., for MI-SBT e-filed 

returns, MA e-file extension status, and NY e-file extension status). 

 

e-org Clients 

The e-org Clients view is the default All Clients view, with the addition of the E-Organizer Received and 
E-Organizer Sent columns. This can be used to view and organize your client list based on the use of E-
Organizers. 

P  If you do not use the E-Organizer feature in your practice, you can still make good use of this client 

view. For example, you may want to include contact information in the All Clients view (phone numbers, 
email addresses, etc.) and then use the e-org view to display tax related information (AGI and AMT 
amounts, estimated payments, etc.). 
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Customizing Views 
At the Display tab in Options, the columns for each of the three views can be arranged to suit your needs 
and preferences. The only permanent column in each view is the Client Number column. 

 

 

To add columns to the display: 

1. Select the view to adjust in the Client View list. 

2. Click the item to add in the Available list.  

3. Click the right arrow to add it to the display. 
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To remove columns from the display: 

1. Select the view to adjust in the Client View list. 

2. Click the item to remove in the Display list. 

3. Click the left arrow to remove it from the display. 

 

To rearrange the display columns: 

1. Select the view to adjust in the Client View list. 

2. Click the desired category in the Display list. 

3. Click Up or Down to move the column. 

F You can also move a column to its desired position by clicking and dragging the column heading 

at the Clients tab. 

 

At the Clients tab, the columns display left to right in the order they appear in the Display list (the top item 
corresponds to the left, or first, column). It is the first column at the Clients tab that determines the sort in 
the display. 

F If the Automatically adjust column widths box is checked, the program attempts to fit the columns 

to the size of the window. If the Left Column Fixed box is checked, the program displays the left column 
even when you scroll the list to the right. 
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Chapter 2: Entering Data Efficiently 

 

Keystrokes Overview 
You can accomplish almost any function in the program without ever having to use the mouse. Following 
is a description of some of the keystrokes available in various areas of the program. 

Opening Other Modules 

 Individual [Ctrl]+[Alt]+[I]   Exempt Org. [Ctrl]+[Alt]+[E]  

 Partnership [Ctrl]+[Alt]+[P]   Estate [Ctrl]+[Alt]+[T]  

 Corporate [Ctrl]+[Alt]+[C]   Gift [Ctrl]+[Alt]+[G]  

 S-Corporate [Ctrl]+[Alt]+[S]   Benefit Plan [Ctrl]+[Alt]+[B]  

 Fiduciary [Ctrl]+[Alt]+[F]    

 

[Enter]  and [Esc]  are two of the more common keystrokes that you can use. 

Use [Enter] or [Return] to: 

 Access the Detail tab for a client from the Clients tab. 

 Access a selected input screen in the Detail input. 

 Navigate from field to field within an input screen.   

Use [Esc] to: 

 Exit the Detail, Forms or Diagnostics tabs.   

 Change the focus from an input field to the list of a selected screen.   

 Exit the screen in which you are working (when pressed twice). 

 

Moving Between the Main Program (Upper) Tabs 

 [Alt]+[Underlined letter on each tab]  -OR-  [Alt]+  [²] or [±] 

 

 

 

  

[Alt]+[ k]  or  [c]  or  [d]  or  [f]  or  [ i]  
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Moving Between the Detail and Forms (Lower) Tabs  

  [Ctrl]+[²] or [±] 

 

 

 

Selecting Multiple Clients  

 Group Select client files ð [F3] 

 [Spacebar] (selects a client) + [³] or [°] arrows (moves to next client) + [Spacebar] ð repeat for 

all clients 

 

Client Maintenance 

 Add a new client file ð [Ctrl]+[A] 

 Backup client(s) to a specified location ð [Ctrl]+[B] 

 Delete client(s) ð [Ctrl]+[D] 

 Find a client file ð [Ctrl]+[I ] 

 

Moving Within the Detail Input Screens 

 Move from a grid to the first field in expanded input ð [Ctrl]+[Tab] 

 Cycle between input (grid or interactive) and the lists - [Ctrl]+[Tab] 

 Open and expand pre-defined tables ð [Alt]+[°] -OR- [Ctrl]+[T] 

 Move to the same field in next property/asset or grid input ð [Ctrl]+[°] 

 Move to the same field in previous property/asset or grid input ð [Ctrl]+[³] 

 Mark a check box - [Spacebar] 

 Change or add a state ð [F6] 

 

Detail 
Tabs 

Forms 
Tabs 
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Moving Within the Forms Tab 

 Move between the form being viewed and the lists ð [Tab] 

 View statements and worksheets on current form ð [Ctrl]+[S] 

 Type the number or letter of a form or schedule to quickly view it (i.e., typing "b" displays 

Schedule B) 

 

Moving Within the Diagnostics Tab 

 Access the Diagnostic Filter list ð [Alt]+[S] 

 Access the Critical Diagnostic list- [Alt]+[W] 

 Access the Informational Diagnostic list ð [Alt]+[O] 

 Jump to input on selected diagnostic ð [Enter] 

 

  A template of keyboard shortcuts can be accessed by clicking the following link: 
http://www.lacertesoftware.com/resources/2002keyboard.pdf 

 

http://www.lacertesoftware.com/resources/2002keyboard.pdf
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Find Items 
The Find Items feature allows you to search either for descriptive information that you entered in a return 
or for input screens that affect specific schedules or forms. The results are displayed as hyperlinks that, 
when clicked, "jump" you to the applicable input screens. 

To use Find Items: 

1. From the Detail tab, click the Find button. (You can also press [Ctrl]+[F]  or click Find Items 
on the Detail menu). 
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2. Choose a category in which to search. 

a. Select Find an input field to search for words contained in program input fields. 

  

 

b. Select Find input for a form to search for input screens that affect schedules or forms. 
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c. Select Find user entered text to search for descriptive information entered in the 
program. 
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Notes 
The Notes screen can be used to create supplemental items. These items can be explanations, supporting 
statements, reminders for the preparer, manual calculations - any note or information that needs to be 
printed with the return (federal and/or states). You can: 

 Collate the note with General Information (Worksheets) and statements 

 Add an opening or closing paragraph in the client letter 

 In the Partnership, S corporate, and Fiduciary tax programs, add supplemental information for the 

Schedule K-1 

To enter Notes: 

1. Open the Notes screen from the Contents tab of the Detail input. 

F Notes screens are available in every module of Lacerte. 

2. Click the type of note in the Print As section. 

 

 

 

 

 

 

 Worksheet Notes print before the tax return in Supplemental Information by default 

 Statement Notes print after the tax return in Supplemental Information by default 

 Letter Misc 1 and Letter Misc 2 print as opening and closing paragraphs on the Client 

Letter. The program assigns the text you type to the [MISC1] and [MISC2] keywords 

F Letter entries can be formatted using the toolbar at the top of the Notes screen 

 (1065, 1120S, 1041) Schedule K-1 Notes print as supplemental information for each 

partner's, shareholder's, or beneficiary's Schedule K-1. The program assigns the text you 

type to the [SCHK1] keyword for the Client Letter 

3. Click Add to create additional notes. To edit an existing note, click the note in the list. 

4. Type the desired contents of the note. As you enter the text of your notes the text automatically 
wraps from one line to the next. 

F Notes printed with the statements are included with filing copy and with e-filed returns, while notes 

printed with worksheets are not included. 

Available in 
all modules 

Available only in 
Partnership, S-Corp, 
and Fiduciary 
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Supporting Detail 
The Lacerte tax program prints supporting statements when required by the IRS. Using the Supporting 
Detail feature, you can create additional supporting statements or worksheets for any numeric input field 
for which the program does not automatically print statements. In addition, you can specify where the 
statement prints: with the return, before the return, or as a non-printing memo only.  

To produce Supporting Detail: 

1. Position the cursor in the numeric input field and press [Ctrl]+[E]  (or click ). 

 

2. Edit or accept the title. 

3. Select a Print as option. 

a) Don't print ð notes are viewable within the input only 

b) Worksheet ð notes will print with the general Worksheets (if using the default settings for the 
Items to Print options, this will be before the federal and/or state tax returns) 

  

c) Statement ð notes will print after the federal and/or state tax returns. 

4. Enter the supporting statement information. 

5. Click OK. 
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Once you close the Supporting Detail window, the program automatically adds all entries in the input, 
inserts the total in the related input field, and changes the appearance of button to the right of the field 
reminding you that there is supporting information for the data entry field. 

 

If you choose the MFJ vs. MFS comparison in Client Information, amounts in some screens can be 
allocated between taxpayer and spouse using the TS column in the Supporting Detail input. 

 

The Supporting Detail feature is also used to allocate income and expenses between multiple state 
returns. On multistate returns the title changes from Supporting Detail to Allocate Multi-State 
Amounts, and two additional columns are added: State and Source. Enter the allocated amounts and 
identify the appropriate state by entering its postal abbreviation in the ST column. If necessary, you can 
designate the amount as source (S) or non-source (N)  in the Source column. 

F Source (S) income 

will flow to the 
designated state return 
only (does not go to the 
federal return). Non-
source (N)  income flows 
to the federal return only. 
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Organizer Input 

Organizer Input accelerates the process of entering tax information from Client Organizer pages. The 
Organizer Input displays interactive input screens that are identical to the printed Organizer pages. This 
allows you to enter information in the program line-by-line as it is written on the Organizer pages without 
having to search for applicable screens and input fields. 

 

To open the Organizer Input, press [Ctrl+N]  from the Detail tab, or click Organizer Input on the 
Detail menu. 
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Missing Data Utility 

Use the Missing Data feature to mark input fields in a client's return as missing information. You can then 
create an e-mail message to send to that client alerting them of the needed information or print a report 
for reference or to fax to them. 

 

Tagging Fields 

You can tag input fields in the Detail screens as you are entering data or reviewing a return. These fields 
are displayed with a red dotted line around them. 

F The field(s) being tagged may also contain "questionable" data ð information you are not sure about. 

To tag a field as a Missing Data field: 

1. Right-click on the desired field. 

2. Select Missing Data from the menu. 

 

3. The program outlines the field with red dotted lines.  

F This feature is only available in the Interactive Input; it is not available in the grids. 
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Display Fields and Status  

Once at least one field has been tagged as missing, you can open the Missing Data Utility . This utility 
allows you to create a Missing Data email, link to Missing Data fields, or print a Missing Data report. 

To open the Missing Data Utility , select Missing Data on the Tools menu or click the icon in the 
toolbar. 

 

This utility can be opened from anywhere in the program. 

F You can only open the Missing Data Utility  for one client at a time. If you attempt to access this 

feature with multiple clients selected, Missing Data is grayed out on the Tools menu. 

If you attempt to access this feature for a client that has no fields tagged as missing, you receive this notice: 
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Creating a Report  

When creating a report, you must first select the fields to include. By default, the Missing Data Utility  
includes all fields with a status of Not Sent. 

 
 

You can also elect to change the field names that are used in the report. To change a field name, click the 
name in the Name to use in Report/E-mail column and type in the desired change. 

  

 

To print the report, click Print Missing Data Report. The report prints in landscape format. 

F This report does not print with the tax return and is not part of the Items to Print selections in the 

options. 
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Sending Emails 

To create a missing data e-mail: 

1. Select the fields to include and modify the field names if necessary. 

2. Ensure that you have a valid e-mail address entered. By default, the program populates the Send 
To: field with the taxpayer's e-mail address.  

3. Modify the subject, salutation, and greeting if desired. 

F The program stores the modified greeting.  

4. Click Create E-mail. 

5. The program opens a new message in your default e-mail program. 

F You are notified with each transmission that you could potentially be transmitting personally 

identifiable information via an insecure Internet connection.  

 

The Status of each missing data item is controlled automatically. If you click Create E-mail, the program 
changes the status to Sent and updates the status date. For missing items with a status of Not Sent, the 
status date is the date that the field was tagged. 

P   You can create a Missing Data "test" report from an existing client file, and then email it to 

yourself. That will enable you to view the layout and content of the email the same way your client 
sees it, ensuring that the information you are requesting is presented clearly. 

Additionally, there may be some items tagged as missing that you will be researching on your own, 
and so would not want those included in the email. Simply uncheck the Include box next to those 
items prior to sending the email; they will not be transmitted but will remain in the Missing Data 
Report. 
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Entering Data and Clearing Tags  

Once missing data has been collected, you can easily "jump to" the fields that have been tagged as missing, 
as each item in the Missing Data Utility  window is hyperlinked. When you click a missing data link, the 
program closes the Missing Data Utility  window and takes you that field. Once an amount is entered, 
you are prompted to clear the tag.  

 

Click Yes to remove the tag, or No  to leave the tag. Repeat this process until all tagged fields have been 
addressed. 

 

To clear all missing data tags for a client, select Clear All Missing Data Tags for Client on the Tools 
menu. 
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Schedule D Import 
Based on customer feedback and "hinting" from recent IRS Schedule D instruction changes, the Lacerte 
Product Management and Tax Development teams implemented a simple solution for importing of stock 
transactions that did not require the use of the Data Conductor feature. 

To Import Transactions: 

1. Make sure you have a useable file (.xls or .csv) and that it is formatted to make the process as easy 
as possible. You can only select one file at a time, and password protected files are not supported. 
The columns available for import are: 

o Quantity 

o Description 

o Date Acquired 

o Date Sold 

o Sales Price 

o Cost Or Other Basis 

o Expense of Sale 

2. Open the Schedule D Import Wizard. This can be done from the Clients Tab on the File menu. 
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You can also select Schedule D Import from the Tools menué 

 

éand from within the Dispositions screen by clicking the Schedule D Import button. 

 

3. The Import from Excel Wizard Screen opens. Here you will select Import Options (default is 
Append) and designate transactions (default is Joint and only applicable when importing to a 
married client). 
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When deciding which import option to choose, refer to the following regarding each option: 

o Add: If you select this option to import a file, you will simply add to any existing Schedule 

D information for this client. In other words, importing this file will not affect any 

information that was previously entered in the tax program for this client, regardless of 

how it was entered. 

o Replace: If you select this option to import a file, you will replace any existing Schedule D 

information for this client. In other words, importing this file will overwrite all information 

that was previously imported for this client using this wizard. Any data that was manually 

entered or edited in the tax program will not be affected. 

o Clear: If you select this option, you will simply delete all Schedule D information that was 

previously imported for this client using this wizard. 

4. Select the desired file and click Open. 

 

  



29 

5. In the next screen, you will select which worksheet of the file you are importing and assign 
column headings to the appropriate columns. You can also choose rows to ignore. 

 

6. The next screen allows you to review the information, along with calculated totals. Click Finish to 
complete the import. 

7. After a confirmation screen, you are given the option to Import another file or go directly to the 
input screen. 
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8. Once complete, the transactions show in the Dispositions Screen in imported data color: 
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K-1 Transfer 
You can use the Lacerte K-1 Transfer to 1040 feature to automatically transfer Schedule K-1 information 
from a calendar year-end Partnership, S-Corporation, or Fiduciary tax return to any related person's Form 
1040. Detailed input is transferred to Passthrough K-1s (Screen 20) of the Lacerte Individual Tax program 
for each partner, with separately stated details from the disposition of assets with prior Section 179 
expense transferring to Dispositions (Screen 17). 

Many Schedule K-1 income and expense items are transferred to the input screen to simplify entries on the 
individual tax return. We recommend that all items be reviewed for accuracy and correct treatment on 
each individual partner's Form 1040, particularly those on the supplemental information pages. 

F The K-1 Transfer to 1040 feature does not transfer information for fiscal year end entities 
because the information would appear on the following year's Individual tax return. 

 

Transferring K-1 Information to the Individual Tax Program 

1. Enter the partner's, shareholder's, or beneficiary's client information in the Individual Tax 
program. 

F Social Security Numbers must match between the Individual Tax program and the partner, 

shareholder, or beneficiary in order for the Schedule K-1 Transfer to link information correctly. If 
the K-1 information for that Passthrough entity has already been entered or previously imported 
into the individual return, the EIN must also match. 

2. Open the module that contains the K-1 information. 

3. Open the client in the Client list for whom you want to transfer Schedule K-1 information. 

4. Open the Schedule K-1 Miscellaneous screen. 

 For 1065 partners, use Schedule K-1 Miscellaneous (Screen 32) 

 For 1120S shareholders, use Schedule K-1 Miscellaneous (Screen 36) 

 For 1041 beneficiaries, use Schedule K-1 Overrides/Misc. (Screen 43) 

5. In the sub-client list, click the partner, shareholder, or beneficiary. 

 

6. Select the Export {Partner/Shareholder/Beneficiary} K-1 Data to 1040 check box. 

F When there are pre-existing passthrough properties in the Individual client, enter the property 

number in Number of K-1 activity in 1040 [O] in the Schedule K-1 Miscellaneous/Overrides 
screen to tie the properties together properly or to append a new property. 
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7. Repeat steps 5 and 6 for each Schedule K-1 to be exported. 

8. On the Tools menu, click K-1 Export to 1040. 

  

9. Click Export. 

 

10. When the program finishes exporting the Schedule K-1 information, click OK. 

11. Open the Individual program. 

12. Double-click the client for whom you want to import Schedule K-1 information. This opens a 
new òImport Dataó window. 
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13. In the Activities section, verify all Schedule K-1 activities you want to import are checked. 

 

F By default, the Overwrite user-entered data box is checked. This means that if data exists in 

a field in the K-1 screen in the Individual program, and that same data is being transferred in the 
K-1 data import, the import data "wins". Uncheck this box to leave user-entered data in place. 

14. Review the Activity Detail information. 

F The Prior Amount column will display information upon subsequent imports of data in the 

same tax year. 

15. Review the Diagnostics information. 

F After you click Accept Data, you cannot return to the diagnostics screen, so this is your only 

chance to review the numbers on the K-1 which are NOT imported. 

16. Click Accept Data to transfer the information. You can also click Print to print the data that will 
be imported. 

F If you click Cancel, you can import the data later by selecting K-1 Data Import on the Tools 

menu while in the Detail input. 

17. Click OK. 
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Whenever information in the business entity containing the Schedule K-1 data is changed, you are 
prompted to re-export the client and update the individual client file. 

 

Click Yes to repeat steps 9-16 above. 

 

State Information Transferred 

The following statesõ information is also transferred during the K-1 Export: 

 California 

 New York 

 New Jersey 

 Pennsylvania 

 Illinois 

 

To view a comprehensive list of which fields in each module (1065, 1120S, 1041) are transferred, view the 
following highlighted Help topic in the program (press [F2]  on your keyboard) - 
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Split Joint Return 
The Split Joint Return feature is used to create two MFS returns from one MFJ return. The MFJ Split 
works in conjunction with the MFJ vs. MFS Comparison Worksheet to provide you with an easy way to 
quickly evaluate and split qualified returns. 

When you choose to split an MFJ return, the program creates two new returns, one for the taxpayer and 
one for the spouse. The original MFJ return is not changed in any way.  

It is important to note that the MFJ Split is a one-way split. The program does not support taking two 
MFS returns and combining them into one MFJ return, nor will any changes you make to one return be 
reflected in the other two after the split. 

F You can use the MFJ Split feature in conjunction with the MFJ vs. MFS Comparison Worksheet 

to evaluate returns based on tax liabilities and quickly create two new Married Filing Separate returns. 
However, choosing to file Married Filing Separate can affect other factors such as immigration status. 
These and any other factors should be reviewed thoroughly before electing to file separately. 

Community Property States  

If the taxpayer lives in a community property state and you set the Community Property State option to 
Yes, the program combines all wages and business income or loss, and then splits the amounts equally 
between the taxpayer and spouse. The program allocates all other income and deduction items according 
to the Taxpayer and Spouse designators you have assigned. 
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Itemized Deductions 

The program determines if the standard or itemized deduction is most beneficial to the client, and then 
assigns the appropriate number to the input field: 1 If Must Itemize, 2 If Elect to Itemize, 3 If Force 
Standard Deduction [O] in Screen 25, Itemized Deductions. You can change this option as necessary. 

Rounding 

The Lacerte Tax program rounds all dollar and cents amounts. When you use the MFJ Split to split a joint 
return, the program splits the dollar amount equally. If the division results in a fractional dollar amount, 
the program rounds the result depending on the fractional amount. The program rounds amounts of $.50 
or higher up to the whole next dollar and amounts of $.49 or less are rounded down to the previous dollar. 
The program then allocates that amount to the taxpayer and the remainder to the spouse. 

Items Carried to New Returns  

The following table lists the information that the program duplicates in the new taxpayer and spouse 
separate returns: 

Screen Name Form Number Screen Number 

Power of Attorney/Tax Information Authorization 2848/8821 65 

Request for Copy of Tax Form 4506 67 

Request for Transcript of Tax Return 4506-T 67 

Change of Address 8822 73 

Elections  46 

Claim for Refund or Abatement 843 61 

Reduction of Tax Attributes  982 62 

Multiple Support Declaration 2120 64 

Disclosure Statement 8275/8275R 69 

Release of Claim to Exemption 8332 70 

Asset Acquisition Statement 8594 72 

Work Opportunity Pre-Screening Notice 8850 75 

Application for Employer Identification Number SS-4 80 
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Items Not Carried to New Returns  

The following table lists the information that the program does not carry to the new taxpayer and spouse 
separate returns: 

Screen Name Form 
Number 

Screen Number 

Tax for Children Under 14 8615 43 

Prior Year Summary  48 

Control Totals  49 

Other State Tax Credit Various 52 

Nonresident Alien 1040NR 58 

Amended Return 1040X 59 

Installment Agreement Request 9465 80 

Application for Tentative Refund 1045 60 

Injured Spouse Claim and Allowance 8379 71 

Claim EIC After Disallowance 8862 77 
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Before You Split a Return 

There are some items that should be addressed before you split a return: 

 Verify that the filing status of the return is Married Filing Joint in Screen 1, Client Information. 

 Check the MFJ vs. MFS Comparison box in Screen 1, Client Information. If you do not, the 

following warning appears: 

 

 Verify that the detail input has been allocated between Taxpayer and Spouse, where applicable. 

 Review the MFJ vs. MFS Comparison Worksheet. 

 

To use the Split Joint Return feature: 

1. On the Tools menu, click Split Joint Return. 

2. Check the box to create a return for the taxpayer or the spouse, or both. The program checks 
both by default. 

     

3. Verify or edit the new client number(s). 

4. Click OK. 
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After the program splits the return, the Split MFJ Report is displayed. 

 

The report displays the client names and numbers involved in the split and any diagnostics or information 
related to the split. Click Print to print a report for your records. 
 

REP and E-File Charges 

If you have already been billed for the MFJ return, you will not be billed again for the taxpayer. However, 
you will be billed for the newly created MFS return for the spouse. 

 

 



40 

Family Link (8615) 
This feature links together a family group of returns to compute Form 8615. Form 8615 is filed as part of 
the child's tax return but requires information from the parents' and other siblings' tax returns. The 
Family Link  (8615) transfers all the federal tax information required to complete federal Form 8615 and 
the state forms for California (3800) and Hawaii (N-615), and determines the correct tax rate for the 
child's investment income. 

Once you have setup the parent and child returns, click Family Link (8615) on the Tools menu from 
either the Clients or Detail screen. (A short video tutorial is available for viewing at this point).This opens 
the Family Link setup screen. 

 

 

To use the Family Link (8615): 

1. In the Available Clients list, select the parent. 

2. Click Add Parent.   

3. In the Available Clients list, select the child. 

4. Click Add Child. 

5. Repeat steps 3 and 4 if the parent has more than one child with investment income. 
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6. Click Preview Tax Data. 

 

7. If you want to review the parent's or the child's tax information, select the appropriate category in 
the Data Sections list.   

-OR-  

Click Print to print the parent's and the child's tax information.   

F If you estimated the parent's tax information, check the Parent's Information Is Estimated 
box.   

8. Click Transfer to transfer the parent's or the child's tax information to the correct return(s).   

 

The program transfers tax information for the preparation of Form 8615 and determines the correct tax 
liability for the child's income depending on the higher rate between the parent's and the child's tax return.   

The folder next to the parent's name will appear solid yellow in the Family Links section once their data 
has been transferred. For families for whom the data has not been transferred, the folder next to the 
parent's name will contain a red exclamation mark. 

Once you have transferred the data between the returns and you subsequently change information in any 
return that is part of a family, you are prompted to update the Family Link upon exiting the client. 

 


